	COURSE DESIGNER DOCUMENTATION


Introduction:  This 22-page document is a Reprint of the Course Designer manual, which is a part of the Course Designer software, and can be seen while you are using the Course Designer software by clicking on the “Help” button.
The Course Designer software has been provided as part of the standard DryFire package to give you the ability to create your own targets.
The main use of this software will be by Sporting Clay enthusiasts and by Hunters.
Sporting Clay enthusiasts are always looking for new target presentations and are often confronted with extremely difficult targets.  This software package will allow you the freedom to simulate those difficult targets, and then with the use of the DryFire system and the “Stop Motion” feature, you will be able to unravel the mysteries of any target presentation.  
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Picture of the Course Designer ICON
Designing sporting & FITASC layouts for use with DryFire

Date: 6th August, 2007. Course Designer (c) 2007 The DryFire Corporation. 

Please check the Download page of the DryFire web site for the latest version of the software and User Guide. 

We strongly recommend printing this document for reference. Please use File, Page setup in your browser to select landscape printing. 

Note: layouts designed with earlier versions of Course Designer are not suitable for use with DryFire Version 3. 

Some very important definitions

· A trap is a thing that releases a clay. In real life a trap may release one or two clays but with DryFire a trap releases only one clay. If you want two clays released from the same place you should define two traps at the same place. 

· A shooting stand or station is the place you shoot from. 

· A target is a combination of a stand and one or two traps. 

Why targets are vitally important

It does not matter how many traps or stands you create using Course Designer, none of them will provide targets for you to shoot at unless you specifically create targets and define which stand and which traps are to be used. 

The File menu contains the option to Prepare targets. 

Click here for more details on defining targets. 

Warning about "impossible" layouts

Course Designer does not communicate with the simulator, nor does it try to set up targets ready to display, so it is quite possible to generate a layout that will fail when you use it with the main DryFire software. 

If this happens you should check each aspect of the design in Course Designer. 

· Have you selected the right type of clay? 

· Have you set a launch angle of zero degrees and forgotten to select a rabbit clay type? 

· Have you set the trap launch angle too low or too high? 

· Have you given each trap, and each stand, a meaningful name - not left them as "Trap 1", "Stand 12" etc? 

· Have you set up targets? Don't forget, traps and stands are useless unless they are combined. A stand plus one or two traps makes a target. 

· Have you given each target a meaningful name - "Walk up", "Incoming from tower" etc? 

· Have you set a viewing angle for each target? 

Each stand has a viewing angle but so does each target. 

Check the value for each target or you will generate Error 13 in the main DryFire program because it may be impossible for the shooter to see any of the clay trajectory if you have the wrong viewing angle. 

Double check everything. 

If the layout still fails, send it to us as an email attachment and we will check it out. 

If you get "locked out" of your main DryFire software and it will not load, simply delete the file c:\program files\dryfire\dryfire.ini and start again. 

Advice about setting up a new layout

· Forget about trees, fences and hills until you have the layout working. Just get the traps, stands and targets correct and tested by running the layout in the main DryFire software. When everything is working you can add the trees etc. 

· In a real-world sporting layout the stands may be far apart for safety and other reasons. Don't do this in DryFire or you will be scrolling from left to right all the time to see it. 

It doesn't matter if the clay trajectories for different targets overlap in Course Designer - you will only be shooting one target at a time in the main DryFire software. 

Keep things as compact as possible. 

· If you want two or more traps at the same location (for doubles etc.) it is best to create the two traps at separate locations and then drag them to the same location - use the "Snap to grid" option to make sure they are at the same place. DryFire is more powerful that the real world - you can have lots of traps in exactly the same place! 

Some totally biased advice on learning to shoot

You will never learn to shoot properly if you stick to sporting clays or game shooting. 

We can hear the screams now - "Yes you can!" 

No, you can't! 

How many shots do you get in an average day's game shooting (a few)? How many shots would you get at sporting clays (a few dozen)? How many shots would you get with DryFire (hundreds)? 

Shooting is about technique - getting everything perfect so that the only thing you have to worry about is the target. 

The best path to perfection is doing something that is consistent and repeatable - and then doing it time and time again until you can do it without thinking. 

In favour of skeet - the best discipline for learning to shoot

There is no doubt that Skeet is the very best discipline for those who want to reach the perfection of shooting. The targets are predictable leaving you to concentrate on technique. With sporting clays all the targets are different - it is you against the layout designer as well as you trying to perfect your technique. 

If you have a good technique (discuss it regularly with your instructor) and you can consistently hit 25/25 at Skeet, you are ready for sporting. If you can get a good score at sporting you are ready for game shooting. Don't waste £500 on a day's pheasant shooting until you are certain that you will get a good return for every penny spent. 

DryFire is a serious training aid. Its main purpose is to give you large amounts of practice in the key techniques of clay shooting - hold, target acquisition, swing, fire and follow through. The actual technique you use: maintained lead, swing through, move/mount/shoot; does not matter - you practice what you or your instructor want. 

Sporting targets are fun because they pit you against the layout designer - but for learning and practice they are not the best thing to use because of their element of randomness. 

If you really want to learn to shoot well, you must be willing to put in the practice at the non-random stuff - and Skeet is great for this. 
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· Problems, comments, suggestions and layouts 

· Location axes and angles 

· Hints and tips - including metric v imperial measures 

· Some notes about clays aerodynamics and trap settings 

· The Course Designer screen 

· Moving any object on the screen 

· Adding/editing stands 

· Adding/editing traps 

· Adding/editing starshoots 

· Adding/editing trees 

· Adding/editing hills 

· Adding/editing fences 

· Adding/editing walls/banners 

· Defining targets 

Problems, comments, suggestions and layouts

Please check the DryFire web site (www.dryfire.com) for our contact details. 

If you have a problem, or suggestions, please check the web site support page before contacting us. 

Important note

Course Designer allows you to create layouts/courses for use with DryFire or as a simulation for courses that you may wish to design in real life. 

Course Designer may be used to design any type of sporting or FITASC layout. 

Course Designer is not suitable for designing courses which have to obey "rules". For example, all forms of skeet and trap shooting (National, International and Olympic) are defined in very detailed rule books and DryFire provides layouts which follow those rules exactly. 

Location axes and angles
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Locating objects on the layout

· The X axis is the horizontal axis which runs across the layout. 

· The Y axis is the one that runs from the front to the back of the layout 

· The Z axis is the vertical axis - the height of an object 

The centre of a new layout is assumed to be a X=0, Y=0, Z=0. 

Defining launch direction and viewing angles

The launch direction angle is the direction in which the clay is launched. 

The viewing angle is the direction the shooter is looking. 

These angles are defined in a slightly unusual way - and they go counter-clockwise: 

· 0 degrees is to the right of the layout 

· 90 degrees is towards the back of the layout 

· 180 degrees is to the left of the layout 

· 270 degrees is towards then front of the layout 

In the example above the trap is launching at 90 degrees - towards the back of the layout. The shooter is looking in the same direction because this is a walk-up, away, target. 

Hints and tips

With Course Designer you can create almost any target you can see in real life. 

· You should always assume that you will be taking the shot on the wall directly in front of you - this is the same as taking a real clay in your "comfort zone". Just as you would not take real clays when your body is twisted beyond this zone, so you should not design DryFire targets that do not place the shooting position directly in front of you. 

· Not all targets will "work". This may be for a number of reasons - a simple mistake on your part or selecting the wrong combination of stand and traps for a target. It could also be that you are asking the simulator to do the impossible - see the next point. 

You should expect a well designed layout to involve some imagination and a little trial and error - design the targets, try them in the main DryFire software, modify them using Course Designer and repeat this cycle until you have a layout in which all the targets work well. 

· Just like real traps, the DryFire simulator has mechanical constraints on its movement. For example, if the head is facing vertically upwards it can go up or down but it is physically impossible for it to go sideways! To overcome this with certain targets, those that go over your shoulder on Skeet stands 1 and 7 for example, it is possible to ask the user to mount the simulator facing upwards by a certain angle (Skeet uses 45 degrees.). 

If you create targets that show major changes of direction during flight it is most likely that you have hit the physical constraints. 

In fact, with a little careful thought as to the direction of launch, the angle of view and the angle of the simulator, it is possible to get most targets to work fine. For example, to get a downwards going target (standing on a hillside and shooting a target going downhill) the easiest thing is to put the shooter on a very high stand and the trap on a high tower. The tower trap can launched downwards and the shooter is high enough to shoot at it as it goes downwards. 

· The words "course" and "layout" are used interchangeably in this document - they simply mean a group of targets (stands and traps) stored in a single file for use with DryFire. 

· The word "stand" is used to mean a shooting stand or station. 

· Give each stand and trap a meaningful name when you create it - "Stand 23" and "Trap 31" don't mean as much as "Crossers" and "L-R crosser". 

· A course must contain at least one trap and one stand. 

· A course must contain at least one target: a target is a combination of one stand and one (singles) or two traps (doubles.) 

· Don't forget to create your targets after setting up your stands and traps - use the Prepare targets option from the File menu to do this. The DryFire system displays targets on the wall in front if you - not individual traps and stands. 

If you find that your layout is not allowing you to use certain stands, or to launch certain traps, the chances are that you have not used those stands and traps in target definitions. 

· Use the View button when setting up a stand so that you can see exactly what you will see when using DryFire. 

· To see more of the trajectory of the clay move the stand further away from the clay path - hold down the left mouse button and drag it to a new position. 

· Change the angle and location of the stand until you are happy that you are seeing the clay path correctly. 

· For a vertically rising trap (like a teal) set the three launch elevations to the same value - between 80 and 90 degrees. 

· To create a clay which travels downwards (like a trap mounted on ground sloping downwards away from you) create a stand on a platform (with a "Z" (height) value of 12m or so). Create a trap mounted on a tower (with a value of 12m or so - towers must be a multiple of 3m in height.) Set the three launch elevations to the same negative value so that the trap releases downwards (try -15 degrees to start with.) 

· You can create underground traps if you wish - simply enter a negative "Z" (height) value. The trap may be up to 2 metres underground but it must have a sufficient elevation angle for the clay to appear above ground at some time during its flight. You will be given a warning if the clay never appears above ground. 

· Wind speed can have a dramatic effect on clays so always check this first if you get strange effects such as clays disappearing sky-ward! A 50mps head wind will make a clay rapidly climb and turn back on itself. 

Metric or Imperial measures

The View menu allows you to select metric or imperial measurements - the default is the same as you use in the main DryFire software. 

There are some constraints on imperial measurements because internally Course Designer, and the main DryFire software, store all values using SI (metric) units and only change them to imperial for display on the screen. If you are using imperial measurements you may notice one or two "strange" effects. For example towers for traps must be a multiple of 3m high. Course Designer will always round down to the nearest 3m - which may produce some unusual imperial values! 

Differences: 

· When using metric measurements all distances and lengths are in metres and all velocities (traps and wind speed) are in metres per second (mps). The X and Y values in the bottom right-hand corner of the screen show the position of the mouse cursor in metres. 

· When using imperial measurements all distances and lengths are in yards and all velocities (traps and wind speed) are in feet per second (fps). The X and Y values in the bottom right-hand corner of the screen show the position of the mouse cursor in yards. 

The following items are always shown in metres - irrespective of the measurement system selected: 

· The width of the layout. 

· The grid size. 

Some notes about clay aerodynamics and trap settings

Clays have unusual flight characteristics and they certainly do not behave like the bullets or missiles you find in must books about ballistics. The result of this is that it is very easy to make weird things happen. 

A standard clay has a convex top (domed) and a concave base. To the aerodynamicist this means that the top behaves like a aerofoil, it is a lifting surface, and the bottom behaves like an undercambered wing - the sort of things found on some very old canvas-wing aircraft (and on vintage model aircraft). Undercambered wings tend to create stability in flight - which is fine for very slow flying aircraft but the extra drag generated makes them unsuitable for faster aircraft. 

A clay is rotating as it flies - so it is certainly not like a normal aircraft wing. 

The result of this is that the actual flight path of a clay can appear strange under specific conditions. There are some general rules: 

· A clay will tend to "lift" (curve) in the direction the dome is facing. For normal traps this means that the lift is upwards - which is what we want. For a chandelle trap (where the clay is launched on edge - a 90 degree "clay tilt" in DryFire terms) the clay will curve towards the direction the dome is facing. 

· As a clay slows down it tends to "float" rather than "fly". The concave base begins to act as a parachute and if the clay is still facing upwards (it has a positive angle of attack as we say in aerodynamics) it may float (slip) backwards towards the trap. 

To watch these effect on the range you need to observe the path of the clay from two points: from behind the trap looking directly along the direction the clay is released, and at 90 degrees to the path of the clay. This will allow you to see the change in speed as the clay reaches the top of its flight and the curve imparted by the dome. 

If the wind is blowing the effects will be even more complicated - a clay launched at a high angle into a head wind may well end up on the ground behind the trap! 

An example

Imagine a tower trap, 18m from the ground. Imagine also that the trap elevation has been set to a large angle - say 55 degrees. 

What happens? 

The elevation is high so the clay will start travelling upwards. As its energy decreases it will begin to slow down and float but it will still have an angle of attack of 55 degrees. As it continues to slow down it may slide backwards and, because of the additional 18m height of the tower, it may well end up on the ground at the base of the tower. 

A shooter is on a stand 40m away and facing the tower might find that this clay never came within range of his light load and open chokes! 

The problem is easily solved. Since the clay already has 18m of height from the tower there is no need to launch it at a significant elevation angle - we could set the angle to zero and still have a good target or we could add 10 degrees of elevation to give it an angle of attack to make it lift from the trap. Either method would result in a clay which the shooter would be able to take. 

"Angle of attack"? "Aerodynamics"?

If all this talk of "angles of attack", "aerodynamics" and "undercambered" wings leaves you floundering then you need to have a chat with someone who flies light aircraft or model aircraft. 

Don't forget, DryFire came into existence because the shooter who invented it also happened to build model aircraft and happened to have servo motors and balsa wood in his "bit box"! Please click here for the full history of DryFire. 

The Course Designer screen

Note: you may add up to 200 objects (traps, stands, trees, fences, hills, walls, starshoots) to the layout. 

The menu and tool bar
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The File menu provides: 
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	· New layout file 

This will create a new layout file with a single trap, stand and target definition. 

· Open layout file 

This allows you to open an existing Course Designer layout. 

· Save as layout file 

This will save the current layout. In fact the layout is saved each time you make a change so you need not worry too much about this option. 

Course Designer automatically saves your layout after each change so normally there will be no need to use this option. 

· Add information section 

This allows you to define the text that will be displayed in the main DryFire software when the user clicks on the Info button. 

· Prepare targets 

This allows you to define targets. A target consists of a stand (shooting station) and one or two traps. For doubles you can select simultaneous or on-report doubles. You can also specify the direction in which the shooter should be looking at the start of the target. 

· Exit 

This will end the program. 


The View menu provides: 
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	· From front of layout (or use Ctrl F on the keyboard) 

This will show the 3D virtual reality display from a position in front of the layout and about 20m above it. 

· From above layout (or use Ctrl A on the keyboard) 

This will show the 3D virtual reality layout from above - looking down on the layout. 

· Hide virtual layout 

This will hide the 3D virtual reality display. Select this option again to restore it. 

· Hide trajectories 

This will hide the display of trajectories in the 3D reality display. Select this option again to restore them. 

· Show object labels 

This will display the name of each layout object beside its location. Select this option again to hide them. 

· Using metric/imperial measurement 

This allows you to switch between metric and imperial measurements. By default Course Designer uses the same measurement system as you have selected in the main DryFire software. 


The Help menu provides: 
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	· About 

This will display version and copyright information. 

· User Guide 

This will display this User Guide in your browser. 


The Toolbar contains the following tools: 
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· The trap tool 

Select this tool by clicking left on it, move to any location on the layout and click left again. A window will pop up to enable you to tailor the settings for the trap. 

· The stand (shooting station) tool 

Select this tool by clicking left on it, move to any location on the layout and click left again. A window will pop up to enable you to tailor the settings for the stand. 

· The tree tool 

Select this tool by clicking left on it, move to any location on the layout and click left again. A window will pop up to enable you to tailor the settings for the tree. 

· The hill tool 

Select this tool by clicking left on it, move to any location on the layout and click left again. A window will pop up to enable you to tailor the settings for the hill. Hills may have an angle of 0 degrees (across the layout) or 90 degrees (from front to back of the layout). 

· The fence tool 

Select this tool by clicking left on it, move to any location on the layout and click left again. A window will pop up to enable you to tailor the settings for the fence. 

· The wall/banner tool 

Select this tool by clicking left on it, move to any location on the layout and click left again. A window will pop up to enable you to tailor the settings for the wall or banner. 

· The starshoot tool 

Select this tool by clicking left on it, move to any location on the layout and click left again. A window will pop up to enable you to tailor the settings for the starshoot. 

· The pointer tool 

No drawing tool is selected when you pick this option. You may use it to move round the layout. 

· The refresh tool 

This will write the current layout to your hard disk and read it back to refresh the display. 

Layout size and grid
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The layout width shown across the screen may be: 

· 50m 

· 100m 

· 200m 

· 250m 

· 500m 

· 750m 

· 1000m 

· 1500m 

The grid size may be: 

· 1m 

· 2m 

· 3m 

· 4m 

· 5m 

· 10m 

· 15m 

· 20m 

· 25m 

· 50m 

If the Snap to grid option is selected, all new objects will be drawn at the nearest grid intersection. 

Scroll bar and location in layout
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Use the vertical and horizontal scroll buttons to move around the layout. Each time you click on a scroll button the layout will move by one grid increment. Hold down the button for repetitive scrolling. 

The current location of the mouse cursor within the layout is shown in the bottom right hand corner of the screen. The "X" direction is across the screen (from left to right) and the "Y" direction is up and down the screen (from bottom to top.) 

When the program is first loaded the centre of the screen will show location X=0, Y=0. Positions to the right and upward will be positive, positions to the left and downwards will be negative. 

Symbols used on the layout plan
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The symbols used on the layout plan are: 

· Traps: red dot with red line showing direction of clay release 

· Stand: blue dot with red line showing direction in which shooter is looking 

· Starshoot: black dot with brown dot at centre position and a red line showing which direction the starshoot is facing 

· Tree: green dot 

· Fence: brown line with brown dot at each end and at the centre 

· Wall/banner: black line with brown dot at centre. The red line show the direction that text will face. 

· Hill: green ellipse with brown dot at centre position. 

The 3D virtual-reality display
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The 3D virtual reality display is the same as that shown in the main DryFire software. 

Click on the small display to enlarge it. Click again to shrink it. 

You can use the numeric keypad and other keys to move around the layout. 

	Key
	Movement

	7
	Diagonally left forwards

	8
	Forwards

	9
	Diagonally right forwards

	4
	Left

	5
	Front view

	6
	Right

	1
	Diagonally left backwards

	2
	Backwards

	3
	Diagonally right backwards

	+
	Up

	-
	Down

	Home
	Rotate clockwise

	End
	Rotate anti-clockwise

	Page Up
	Rotate upwards

	Page Down
	Rotate downwards

	Cursor left
	Pivot leftwards

	Cursor right
	Pivot rightwards

	Cursor up
	Pivot upwards

	Cursor down
	Pivot downwards


Moving any object on the screen

To move any object on the layout plan: 

· Move the mouse cursor over the object until its name is shown (move over the brown dot in the centre of hills, fences, walls and starshoots). 

· Hold down the left mouse button. 

· Drag the cross-hair outline to where you want the object to be moved to. 

· Release the left mouse button. 

Adding/editing stands

To add a stand: 

· Click left on the Stand tool in the toolbar 

· Move the cross cursor to the position where you want the stand to be 

· Click left again 

· Edit the information about the stand (see below) 

To edit an existing stand move the cursor over the stand's symbol until its name is displayed then click the right mouse button. 
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Name

Course Designer will have provided a default name but it is best to use one that has meaning for you. For example: "Teal" for a teal stand, "Crosser L-R" for a stand facing a left to right crosser. 

Location

This is the location of the stand within the layout. If the "Z" value (height) is greater than 0 the stand will be placed on a platform. 

Viewing angle

This is the direction in which the shooter is facing when on the stand. "0" will be towards the right, "90" will be away from the front of the layout, "180" will be towards the left etc. 

You can enter the value directly or use the angle indicator by clicking on the angle line you wish to select. The angle indicator works in increments of 10 degrees. 

The View button

Click on the View button to see the layout from the shooter's eye position when on the stand. 

Adding/editing traps

To add a stand: 

· Click left on the Trap tool in the toolbar 

· Move the cross cursor to the position where you want the trap to be 

· Click left again 

· Edit the information about the trap (see below) 

To edit an existing trap move the cursor over the trap's symbol until its name is displayed then click the right mouse button. 
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Name

Course Designer will have provided a default name but it is best to use one that has meaning for you. For example: "Teal" for a teal trap, "Crosser L-R" for a left to right crosser. 

Location

This is the location of the trap within the layout. If the "Z" value (height) is greater than 0 the trap will be placed on a tower. 

Launch direction

This is the direction in which the clay will be launched. "0" will launch towards the right, "90" will launch away from the front of the layout, "180" will launch towards the left etc. 

You can enter the value directly or use the angle indicator by clicking on the angle line you wish to select. The angle indicator works in increments of 10 degrees. 

Clay type

Select the type of clay to be used in the trap. 

Clay tilt

Clays normally rest flat on the arm of the trap ("0" degrees). For chandelle-type traps the clay may be resting at 90 degrees when released. 

Launch elevation angle

This indicates how far above the horizontal the trap is designed to fire. A value of 0 would be horizontal and 90 would be vertical. 

The Average value is the normal angle of elevation. 

The Maximum value is the maximum angle the trap should use. 

The Minimum value is the minimum angle the trap should use. 

For normal traps the three values are set the same. 

For traps which oscillate vertically the nominal value should be the "normal" central angle, the maximum value should be the maximum elevation to be used and the minimum value should be the minimum elevation to be used. 

Horizontal oscillation angle

For traps which oscillate horizontally this should be the amount the trap should oscillate either side of the straight-ahead position. So, a value of 45 degrees would set the trap oscillating between -45 degrees and + 45 degrees - a total swing of 90 degrees. 

For normal traps this is set to 0 degrees. 

Velocity or rabbit distance

For normal traps this is the velocity of the clay on release - expressed in metres per second (metric) or feet per second (imperial). Values of between 10mps and 30mps are "normal". 

For rabbit traps this is the maximum distance the rabbit should roll before falling over. 

Adding/editing starshoots

To add a starshoot: 

· Click left on the Starshoot tool in the toolbar 

· Move the cross cursor to the position where you want the starshoot to be 

· Click left again 

· Edit the information about the starshoot (see below) 

To edit an existing starshoot move the cursor over the starshoot's symbol until its name is displayed then click the right mouse button. 
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Name

Course Designer will have provided a default name but it is best to use one that has meaning for you. 

Location

This is the location of the starshoot layout. 

Facing angle

This is the direction in which the starshoot is facing - towards the shooter. "0" will be towards the right, "90" will be away from the front of the layout, "180" will be towards the left etc. 

You can enter the value directly or use the angle indicator by clicking on the angle line you wish to select. The angle indicator works in increments of 10 degrees. 

Launch velocity

This is the velocity of the clay on release - expressed in metres per second. Values of between 10mps and 30mps are "normal". 

Frame

· Sections: this defines the number of angular sections round the starshoot. 

· Segments: this defines the number of segments going out from the centre of the starshoot. 

· length: this defines the length (in metres) of each frame element within a segment. So, a length of 4m with 5 segments would mean that each "arm" of the starshoot was 20m long. in total. 

Adding/editing trees

To add a tree: 

· Click left on the Tree tool in the toolbar 

· Move the cross cursor to the position where you want the tree to be 

· Click left again 

· Edit the information about the tree (see below) 

To edit an existing tree move the cursor over the tree's symbol until its name is displayed then click the right mouse button. 
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Name

Course Designer will have provided a default name but it is best to use one that has meaning for you. 

Location

This is the location of the tree within the layout. 

Height

This is the height of the tree in metres. 

Adding/editing hills

To add a hill: 

· Click left on the Hill tool in the toolbar 

· Move the cross cursor to the position where you want the centre of the hill to be 

· Click left again 

· Edit the information about the hill (see below) 

To edit an existing hill move the cursor over the hill's symbol until its name is displayed then click the right mouse button. 
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Name

Course Designer will have provided a default name but it is best to use one that has meaning for you. 

Location

This is the location of the centre of the hill within the layout. 

Angle

This is the direction along which the hill is aligned. "0" will be towards the right, "90" will be away from the front of the layout. Hills may only be aligned 0 or 90 degrees. 

You can enter the value directly or use the angle indicator by clicking on the angle line you wish to select. The angle indicator works in increments of 10 degrees. 

Length, Width, Height

The length, width and height of the hill in metres. 

Adding/editing fences

To add a fence: 

· Click left on the Fence tool in the toolbar 

· Move the cross cursor to the position where you want the centre of the fence to be 

· Click left again 

· Edit the information about the fence (see below) 

To edit an existing fence move the cursor over the fence's symbol until its name is displayed then click the right mouse button. 
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Name

Course Designer will have provided a default name but it is best to use one that has meaning for you. 

Location

This is the location of the centre of the fence within the layout. 

Length

This is the length of the fence in metres. 

Angle

This is the direction along which the fence is aligned. "0" will be towards the right, "90" will be away from the front of the layout, "180" will be towards the left etc. 

You can enter the value directly or use the angle indicator by clicking on the angle line you wish to select. The angle indicator works in increments of 10 degrees. 

Adding/editing walls/banners

To add a wall or banner 

· Click left on the Wall/banner tool in the toolbar 

· Move the cross cursor to the position where you want the centre of the wall or banner to be 

· Click left again 

· Edit the information about the wall/banner (see below) 

To edit an existing wall/banner move the cursor over the wall/banner's symbol until its name is displayed then click the right mouse button. 
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Name

Course Designer will have provided a default name but it is best to use one that has meaning for you. 

Location

This is the location of the centre of the wall/banner within the layout. 

Length

This is the length of the wall/banner in metres. 

Width

This is the width/thickness of the wall/banner in metres. 

Height

This is the height of the wall/banner in metres. 

Angle

This is the direction along which the wall/banner is aligned. "0" will be towards the right, "90" will be away from the front of the layout, "180" will be towards the left etc. 

You can enter the value directly or use the angle indicator by clicking on the angle line you wish to select. The angle indicator works in increments of 10 degrees. 

Message

This allows you to define the text to be shown on the wall/banner. 

Font name

This allows you to select the font to be used. 

Font size

This allows you to select the size of font to be used. 

Defining targets

A target consists of a stand and one or two traps. 
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List of targets currently defined

This shows a list of targets already defined. 

Click on Add to add a new target. 

Click on Delete to delete a target. 

Click on a target in the list to see/edit its details. 

Name

The name of the target. Use a name which will have some meaning when you are using the layout with DryFire. 

Stand

The stand to be used for this target. 

First trap

The first (or only) trap to be used for this target. 

Second trap

The second trap to be used if this is a doubles target. 

Target type

The target type: 

· Single 

· Simultaneous double 

· On-report double 

Viewing angle

The normal viewing angle when the shooter is on the stand. By default, this value is taken from the viewing angle for the stand. 
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